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PREFACE
Every effort has been made to ensure that the information in this document is complete, 
accurate, and up-to-date. The manufacturer assumes no responsibility for the results of 
errors beyond its control. The manufacturer also cannot guarantee that changes in software 
and equipment made by other manufacturers and referred to in this guide will not affect 
the applicability of the information in it. Mention of software products manufactured by 
other companies does not necessarily constitute endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful 
as possible, we make no warranty of any kind, expressed or implied, as to the accuracy or 
completeness of the information contained herein.

Copyright © 2009 Oki Data Corporation. All rights reserved.

Oki is a registered trademark of Oki Electric Industry Company, Ltd.

Oki Printing Solutions is a trademark of Oki Data Corporation.

Energy Star is a trademark of the United States Environmental Protection Agency.

Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corporation.

Apple, Macintosh, Mac and Mac OS are registered trademarks of Apple Inc.

Other product names and brand names are registered trademarks or trademarks of their 
proprietors.
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NOTES, CAUTIONS AND WARNINGS

NOTE
A note provides additional information to supplement the main text.

CAUTION!

A caution provides additional information which, if ignored, may 
result in equipment malfunction or damage.

WARNING!

A warning provides additional information which, if ignored, may 
result in a risk of personal injury.
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NETWORK CONFIGURATION

INTRODUCTION

Your machine incorporates a fast 100BASE-TX/10BASE-T network interface. This guide 
explains the functionality of the built in network interface. Access for interconnection and 
producing self-diagnostic test and configuration printouts is provided via an interface panel 
at the rear of the machine.

This network interface supports IEEE802.2, IEEE802.3, Ethernet-II and SNAP for IPX/SPX,  
and can detect those frame types automatically for IPX/SPX(NetWare) functions.

Also, the interface supports major protocols such as TCP/IP, IPX/SPX (NetWare) and 
NetBEUI.

This guide details the network interface specification and several software utilities.

NOTE
Not all utilities, features or protocols are supported by every operating 
system. Please check with your User’s Guide and support website for latest 
information.
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ur, 
SPECIFICATION

Network Information Printing   

With the machine power switched on, press the push-button located on the network 
interface panel (at the rear of the machine) for more than three seconds and release. The 
configuration settings are printed.

On the first page of the Network Information that is printed out, under the heading “General 
Information” the MAC Address is given. For example:

MAC ADDRESS 00808784E3F1

The Ethernet address is therefore: 00:80:87:84:E3:F1

Frame Types IEEE 802.2
IEEE 802.3
Ethernet-II, SNAP, AUTO

Network Interface 100BASE-TX

10BASE-T
Network Protocols TCP/IP V4, V6

IEEE 802.1X

Network layer: ARP, RARP, IPv4/v6, ICMPv4/v6

Session layer: TCP, UDP

Application layer:LPR, FTP, TELNET, HTTP, 
IPP, SMTP, WINS, DHCP/BOOTP, SNMPv1/v3, DNS, DDNS, UPnP, Bonjo
SSL/TLS, POP3, SNTP, WSDPrint, Kerveros

IPX/SPX (NetWare 3,x/4,x/5,x/6 with full NDS and NDPS)

Remote printer mode (max.8 file servers)
 

Print server mode over IPX/SPX (max.8 file servers, 32 queues)
 

Encrypted password supported in print server 
mode SNMP

EtherTalk: ELAP, AARP, DDP, AEP, NBP, AIP, RTMP, ATP, PAP  

NetBEUI/NetBIOS over TCP

SMB, NetBIOS over TCP

IEEE802.1X EAP-TLS, PEAP
Functions                   configuration setting printing

Monitoring and configuration by Web browser

Printer status notification by E-Mail

NOTE
Not all utilities, features or protocols are supported by every operating 
system. Please check with your User’s Guide and support website for latest 
information.
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P or 
CONFIGURATION UTILITIES

You can configure the network interface (NIC) by using one of the following methods:

USING QUICK SETUP

Quick Setup utility allows you to configure the network interface easily and simply without 
installing any software packages.

You can configure the following:

> Enable/disable TCP/IP, NetWare, EtherTalk, NetBEUI protocols.

> Set IP address, Subnet Mask and Gateway for TCP/IP manually or by using DHCP.

> Set NetWare mode and create Queue/Print Server/Printer objects.

> Zone name and Port name for EtherTalk.

Configuration requires a PC with Windows 2000, XP or Vista operating system, running TCP/I
IPX/SPX (NetWare).

This utility can only be used on a PC that can be connected to the network with TCP/IP or 
IPX/SPX.

This utility must be used on a PC that is located on the same segment as the printer.

1. Insert the CD-ROM into the CD-ROM drive. The Setup Utility starts automatically. 
If it does not start, double-click \setup.exe (in the root directory) on the CD-
ROM.

2. If you agree to the User Licence Agreement, click Next.

UTILITY FEATURES SYSTEM 
REQUIREMENTS

Quick Setup Configure the NIC easily and 
simply without installing any 
software packages into your 
system. You can set the 
following:
> Enable/disable TCP/IP, 

NetWare, EtherTalk, NetBEUI 
protocols.

> Set IP address, Subnet Mask 
and Gateway for TCP/IP 
manually or by using DHCP.

> Set NetWare Mode and 
create Queue/Print Server/
Printer objects.

> Zone name and Port name 
for EtherTalk.

Windows 2000/XP/Vista (TCP/
IP protocol or IPX/SPX 
protocol should be installed).

Admin Manager Configure the NIC in detail.

Web Browser Configure the NIC and printer 
by using a Web browser such 
as Microsoft Internet Explorer 
or Netscape Navigator.

Microsoft Internet Explorer or 
similar.

Operating system that 
supports Web browser.

Telnet Configure the NIC using 
TELNET.

Third-party vendor developed 
TELNET client package.

A TELNET Application is 
standard in Windows/UNIX/
Linux.

SNMP The machine and network 
card can be controlled using 
third-party vendor developed 
SNMP application.

Third-party vendor developed 
SNMP application.
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3. Select the appropriate language.

4. Select Software Utilities 2.

5. Select the Network Setup Card Install link.

6. Select your language.

7. Select Oki Device Quick Setup and follow the on-screen instructions.

8. When the settings are correct, click Execute. The new settings are transmitted to 
the network card but it still operates with pre-transmission settings.

9. Click Finish to validate the new settings. 

10. Switch the printer off for 15 seconds and on again.

USING ADMINMANAGER

AdminManager is a powerful Microsoft Windows-based utility to configure all network 
interface functions easily and intuitively via a graphical user interface. 

Configuration requires a PC with Windows XP/2000 Advanced Server or Vista, running TCP/
IP or IPX/SPX (NetWare).

This utility can only be used on a PC that can be connected to the network with TCP/IP or 
IPX/SPX and must be used on a PC that is located on the same segment as the printer.

NOTE
Not all utilities, features or protocols are supported by every operating 
system. Please check with your User’s Guide and support website for latest 
information.

4
5
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INSTALLATION

1. Insert the CD-ROM into the CD-ROM drive. The Setup Utility starts automatically. 
If it does not start, double-click \setup.exe (in the root directory) on the CD-
ROM.

2. Select the appropriate language.

3. Select Software Utilities 2.

4. Select the Network Setup Card Install link.

5. Select your language.

6. Select Oki Device Standard Setup.

7. If you want to install AdminManager on to your local drive, select Install and 
Execute. Otherwise, select Execute from CD-ROM. Follow the on-screen 
instructions.

8. To run AdminManager, check Yes for Do you wish to execute AdminManager? 
and click Finish. Otherwise check No and click Finish.

3
4
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INTERFACE

Select Start > Programs>Oki Setup Utility > Admin Manager.

MENU ITEM FUNCTION

File Search Search printers in your network and list all printers.

Status System 
Status

Displays current NIC 
configuration. Configuration 
data can be saved as log file.

List of 
Configuration 
Items

Displays current NIC 
configuration. Configuration 
data can be saved as log file.

Setup Oki Device 
Setup

Configure the network interface (NIC).

Setup by 
HTTP

Launch the default browser in your environment to 
access the selected printer’s web page.

Setup by 
TELNET

Launch TELNET application in your environment to 
access the selected printer’s TELNET port.

Create 
NetWare 
Queue

Create a NetWare queue.

Note: Only visible when using Netware.

Delete 
NetWare 
Object

Delete NetWare object.

Note: Only visible when using Netware.

Reset Reset the selected network interface card.

Test Print Print self-diagnostic test pages.

IP Address 
Setup

Set static IP address of network interface card 
manually.
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DEVICE SETUP

Device Setup allows you to configure the network interface. Type the root password 
(default value is the last 6 characters of the MAC address) to configure. Remember that the 
root password is case sensitive. If the MAC address contains any alpha characters, type 
them as upper case. Device Setup contains details for the following tabs:

> General

> TCP/IP

> NetWare

> EtherTalk

> NetBEUI/NetBIOS

> SNMP

> E-Mail(Send)

> E-Mail(Receive)

> SNTP

> Maintenance

> SSL/TLS

> IEEE 802.1X

> LDAP

> Kerberos

The following section explains each tab’s functionality.

NOTE
Not all utilities, features or protocols are supported by every product. Please 
check with your User’s Guide and support website for latest information.
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General Tab 

This allows you to set or change the root password used for Admin Manager, TELNET and 
FTP.

ITEM EXPLANATION

Change root 
password

You can set/change the root password for 
AdminManager, TELNET and FTP.
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TCP/IP Tab 

This allows you to configure TCP/IP related items.

ITEM EXPLANATION

Use TCP/
IP 
Protocol

Set TCP/IP protocol as enabled/disabled.

Use DHCP/BOOTP Check this item if IP address, 
subnet mask, default gateway 
and IP addresses for DNS 
primary server and secondary 
servers are retrieved from the 
DHCP or BOOTP server. 
Otherwise, leave unchecked.

Use IPv6 Enables IPv6.

IP Address Set the IP address of the 
selected network interface 
card.

Subnet Mask Set the subnet mask of the 
selected network interface 
card.

Default Gateway Set the default gateway of the 
selected network interface 
card.

Auto 
Discovery 

Configure items related to 
Network PnP

Use to select Network PnP and 
Bonjour, and to set device 
name.

DNS 
Server…

Set IP addresses for 
DNS primary and 
secondary servers.

Windows 
Rally...

Use WSD Print

Use LLTD

check to enable/disable.

WINS 
Server...

Set IP addresses for 
WINS primary and 
secondary servers and 
to enter scope ID.

xxxxx
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NetWare Tab

This is where you can configure NetWare related items.

ITEM EXPLANATION

Use NetWare 
Protocol

Set NetWare protocol as enabled/disabled.

Use IPX 
Protocol / Use 
TCP/IP Protocol

Set protocol to use.

Print Server 
Name

Set Print Server name.

Frame Type Set primary NetWare frame type.

Operation Mode Set NetWare mode.

Check box 
beside Bindery 
Setup

Check if you want to use the Bindery mode and Bindery Setup 
button becomes available. If it is unchecked, the button is 
greyed out.

Bindery Setup Configure items related to Bindery 
mode.

In this dialogue box, the following 
items can be configured:

Password Set password for Print Server.

Job Polling Time Set print job polling interval in 
seconds.

NDS Setup Set NDS tree and context where 
Print Server was created.
Network configuration > 15



EtherTalk Tab 

This allows you to configure EtherTalk related items.

RPRINTER 
Setup

Available if you select 
RPRINTER mode in 
Operation Mode.

By selecting the RPRINTER 
button, this is displayed:

Here you can specify print servers 
to which the printer can be 
connected.

Time Out Set duration from the last data’s 
arrival to freeing of the port in 
seconds.

Printer Name Set the NetWare printer object name.

ITEM EXPLANATION

Use EtherTalk 
Protocol

Set EtherTalk protocol to enabled/disabled.

Printer Name Set EtherTalk Printer object name.

Zone Name Set the zone name to which the printer belongs.

ITEM EXPLANATION

xxxxx

xxxxx
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NetBEUI/NetBIOS Tab 

This allows you to configure NetBEUI/NetBIOS related items.

SNMP Tab

This allows you to configure SNMP related items.

ITEM EXPLANATION

Use NetBEUI 
Protocol

Set NetBEUI protocol to enabled/disabled.

Use NetBIOS 
over TCP

Set NetBIOS over TCP to enabled/disabled.

Short Printer 
Name

Set a name for the printer.

Workgroup Set a work group name to which the printer belongs.

Comment Set the comments for the printer (optional).

ITEM EXPLANATION

Use SNMP 
Service

ENABLE or DISABLE the SNMP protocol. 

SNMPV1+V3 Select from the drop-down box which (or both) of these to use.

SNMPV1 
Settings

SNMP Read & 
Write Community.

Enables these passwords to be changed.

SNMPV3 
Settings

Enables Authorisation and Privacy (Encryption) setup to be 
done.

SysContact Set SysContact (printer manager) name.

SysName Set SysName (printer model name).

SysLocation Set SysLocation (the location where the printer is installed).
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Printer Trap 
Setup…

By selecting the button, the 
following dialogue box is 
displayed:

In the dialogue box, the 
following items can be 
configured:

Printer Trap 
Community Name

This community name is assigned to 
outgoing printer status traps such as off-
line, paper out, etc.

TCP#1–5 Set the IP addresses to which a Trap 
packet will be sent. You can set up to five 
IP addresses, with the following details:
Printer Reboot
Receive Illegal
Online
Offline
Paper Out
Paper Jam
Cover Open
Printer Error

IPX Set node address and network address 
to which a Trap packet will be sent.

By selecting the button, the following 
dialogue box is displayed:

In the dialogue box, the following items 
can be configured:
Online
Offline
Paper Out
Paper Jam
Cover Open
Printer Error

ITEM EXPLANATION
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E-Mail (Send) Tab

This allows you to configure SMTP related items.

ITEM EXPLANATION

Use SMTP 
Transmit 

Check to enable SMTP.

SMTP Server 
Name

Enter name of the SMTP server.

Printer E-Mail 
Address

Enter the printers e-mail address.

Destination 
Address 1 - 5

Set the following parameters:

Destination Address Set E-Mail address to which email 
should be sent.

Notify Mode Select PERIOD or EVENT.

When PERIOD is selected:

Check time Used to set the interval at which the 
selected events are checked. An e-
mail will be sent at the specified 
interval for each event selected.

Period mode Set ON/OFF for the events listed.

When EVENT is selected:

Event Mode Select:

ENABLE (ON), DISABLE (OFF) or 
IMMEDIATE (NOWAIT) for the listed 
events. If ENABLE (ON) is selected, 
the check interval can be set (in 
hours and intervals of 15 mins).

Attach Info... Select whichever information is to be included in the e-mail.

Comment... Set up to four lines of text to be included with the e-mail as 
comments.
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E-mail (Receive) Tab 

Your machine supports an e-mail reception function (SMTP/POP3) allowing the printer to 
print PDF files attached to e-mails.

Authentication... Used to set the following security information:

SMTP Encryption 
Algorithm

Select required option from the 
drop-down menu. Select from: 
None, SMTPS, STARTTLS

SMTP Authentication 
Method

Select required option from the 
drop-down menu. Select from: 
None, SMTP, POP 

User ID Set the User ID for Authentication.

User Password Set the User Password for 
Authentication.

Others... Set the following:

SMTP Port Number Set the SMTP port number (default 
is 25).

Reply to address Set the E-mail address used for the 
[Reply to] field in the mail header.

ITEM COMMENTS

Use POP Receive Enable/disable receiving E-Mail via POP3. 

POP3 Server Set the IP address or host name of the POP3 server. 

POP3 Server UserID Set User ID for POP3 server. 

POP3 Server Password Set a password for the POP3 server.

POP Detail… Set the following:

Use APOP Select if you want to use APOP.

POP3 Port 
Number

Set the port number for APOP  (default 
is 110).

Mail Polling 
Time

Set interval to retrieve E-Mail(s) from 
the POP3 server. Selectable values,  
OFF, 1min, 5min (default), 10min, 30 
min, 60 min.

POP 
Encryption 
Algorithm

Select required option from the drop-
down menu. Select from: None, POP3S, 
STARTTLS

Use SMTP Receive  Enable/disable SMTP receive.

ITEM EXPLANATION
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SNTP Tab 

In this Tab, you can configure SNTP related items.

SMTP Detail... SMTP Receive 
Port Number

Set port number (default is 25).

Domain Filter… Set the following:

Use Domain 
Filter

Enable/disable domain filtering.

Filter Policy Select ACCEPT (the default) or DENY.

Domain Filter Define up to five domain filters.

ITEM COMMENTS

Use SNTP Enable/disable SNTP (Simple Network Time Protocol).

NTP Server 1 
Address

Set the IP address or host name for NTP Server 1.

NTP Server 2 
Address

Set the IP address or host name for NTP Server 2.

Adjust Interval  Set the interval for sending time update requests to the 
server. Select 1 hour (the default), 12 hours or 24 hours.

Local Time Zone Set the local time zone from -12:00 to +13:00. Minute 
interval is selectable from 00 (the default), 15, 30 or 45.

Daylight Saving When this is selected, one hour is added to the local time.

ITEM COMMENTS
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Maintenance Tab

ITEM COMMENTS

LAN Scale Select NORMAL (the default) or SMALL.

Note: For small scale networks (with no routing), choose the 
SMALL setting. For more complex networks choose 
NORMAL.

IP Filter Setup… The following items can be configured:

Use IP FIlter Enable/disable IP Filtering. Default is 
disabled.

Admin IP 
Address

Set the administrator IP address.

IP Address 
Range

Set up to 10 IP Filter address ranges: IP 
Filter Range 1 through IP Filter 
Range 10.

Printing Enable/disable printing of the specified 
IP address range. Default is disabled.

Configuration Enable/disable changing IP address 
ranges. Default is disabled.

Service… The following features can be selected by clicking their check 
box.

Use TCP/IP Protocol
Use NetBEUI Protocol 
Use NetBIOS over TCP
Use NetWare Protocol
Use EtherTalk Protocol
Use FTP Service
Use Telnet Service
Use Web Service
Use IPP Service
Use SNMP Service
Use SMTP Transmit
Use POP3 Protocol
Use SNTP
Use encrypted communication for configuration data
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SSL/TLS Tab

ITEM COMMENTS

Cipher Level Set the strength of encryption:

Strong = highest security, slowest speed

Standard = medium security, medium speed

Weak = least security, fastest speed

Self-signed 
Certificate

For IPP encryption within an organisation’s internal 
network (intranet).

Create 
Certificate…

When Self-signed Certificate is selected, the following 
items are configured: 

Common Name The printer’s IP Address appears here.

Organisation Enter the name of your organization.

Organisation 
Unit

Optional. Allows you to enter a 
subdivision or department name.

Locality Enter the name of the city where the 
organization is located.

State/Province Enter the state or province where the 
organisation is located.

Country/Region Enter the country or region where the 
organisation is located.

Key Exchange 
Method

Select RSA (the default) or 
Diffie-Hellman(DSS).

Key size Select 512, 1024 (the default), or 2048 
bits.

Term of Validity Enter a starting and ending date 
(month/date/year) for which the 
certificate is valid.
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CA-signed 
Certificate…

Used for web encryption to provide security when printing 
over the internet. Requires an outside certification service 
which must be purchased separately.

Create 
Certificate…

When CA-signed Certificate is selected, the following items 
are configured:

Common Name The printer’s IP Address appears here.

Organisation Enter the name of your organisation.

Organisation 
Unit

Optional. Allows you to enter a 
subdivision or department name.

Locality Enter the name of the city where the 
organization is located.

State/Province Enter the state or province where the 
organisation is located.

Country/Region Enter the country or region where the 
organisation is located.

Key Exchange 
Method

Select RSA (the default) or 
Diffie-Hellman(DSS).

Key size Select 1024 (the default) or 2048 bits.

ITEM COMMENTS
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IEEE802.1X Tab

ITEM COMMENTS

Use 
IEEE802.1X

Enable/disable.

EAP Type The following Extensible Authentication Protocols 
can be configured:

EAP-TLS Selects Extensible Authentication 
Protocol - TLS.

PEAP Selects Protected Extensible 
Authentication Protocol.

EAP User Enter EAP User name.

EAP Password Enter EAP password.

Use SSL/TLS 
Certificate

Enable SSL/TLS certification.

Authenticate 
server

Enable Server Authentication.

Certificate Client 
certificate

File: (User can specify).

Password: (User can specify).

Options to Import, Delete, View.

CA certificate File: (User can specify).

Password: (User can specify).

Options to Import, Delete, View.
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LDAP

ITEM COMMENTS

LDAP Server Enter LDAP Server name.

LDAP Port 
Number

Enter LDAP port number (default is 389).

LDAP Timeout Set LDAP timeout (default is 30).

Maximum 
Entries

Set maximum entries (default is 100).

Authentication 
Method

Select authentication method from the drop-down 
menu. Select from: Anonymous (default), Simple, 
Digest-MD5, Secure Protocol

Authentication 
User ID

Enter user ID.

Authentication 
User Password

Enter user password.

Encryption 
Algorithm

Select encryption algorithm from the drop-down 
menu. Select from: None (default), LDAPS, 
STARTTLS

Search Filter... Search root Search root.

Attribute Name1: cn

Name2: sn

Name3: givenName

Mail Address: mail

Additional 
Filter

Enter additional detail (optional).
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Kerberos

IP ADDRESS SETUP

If you only use TCP/IP and the printer has not yet been configured, occasionally it may not 
be displayed on AdminManager. You can configure the IP address of the printer by this 
function.

1. Select IP Address Setup from the Setup menu.

2. Set Ethernet Address and IP Address then select OK.

The Ethernet Address (MAC address) is displayed during the self-diagnostic test.

ITEM COMMENTS

Domain Enter Domain.
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OPTION MENU

In the Option menu, the following item can be selected:

HELP MENU

In the Help menu, About is available as well as revision information for AdminManager.

USING A WEB BROWSER

If the printer is connected to the network using TCP/IP, its settings and the printer menu 
settings can be configured using a Web browser. Refer to the relevant manuals for details 
of how to launch and use the browser.

ITEM EXPLANATION

Use TCP/IP 
Protocol

If this item is selected, AdminManager uses TCP/IP protocol to 
search/configure network interface cards.

Use IPX/SPX 
Protocol

If this item is selected, AdminManager uses IPX/SPX protocol 
to search/configure network interface cards.

Environment 
Setup

TCP/IP Tab

Set broadcast addresses that are used 
to search printers using the TCP/IP 
protocol. If Use TCP/IP protocol is 
unchecked, the search will not be 
carried out using TCP/IP.

NetWare Tab

Set network addresses that are used to 
search printers via NetWare protocol. If 
there any many NetWare file servers on 
your network, specify the network 
address to which the network card 
belongs. If Use NetWare protocol is 
unchecked, the search will not be 
carried out using NetWare, but if Auto 
Search is selected, AdminManager will search all networks 
that AdminManager can detect.

SNMP Tab

Obtain the printer name via SNMP - 
Select.

Enter Community name. 

Add and Delete.

TimeOut Tab

Search Every: Set response waiting 
time from a network card in seconds.

Time Out: Set time out between 
AdminManager and the network 
interface card in seconds.

Retry: Set how many times the retry 
will be carried out between 
AdminManager and the network interface card.
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MICROSOFT INTERNET EXPLORER

1. Select Internet Options in the Tools menu.

2. Click on the General tab and click Settings in Temporary Internet files.

3. Select Every visit to the page in Check for newer versions of stored pages.

DEFAULT USER NAME AND PASSWORD

To apply configuration changes using a Web browser, you will be prompted for a username 
and password. The username is root and the default password is aaaaaa.

The root password can be changed to allow you to configure the printer by using a Web 
browser/TELNET/AdminManager. To change the root password, select Change Network  
Password in the Network Setup-Security and follow the on-screen instructions.

ADJUSTING PRINTER SETTINGS

The network addresses used in this manual are shown as examples only. Network 
addresses used in your installation must be generated from your own network.

1. Configure the IP Address, Subnet Mask and Gateway for the network card. Launch 
the Web browser, enter the IP Address of the network interface card in Address 
(Location/Position) and press the Enter key.

2. Select a tab and items to be changed in the left frame. You need to log in as root to 
be able to configure all items. Non-root users cannot configure all items.

NOTE
To apply configuration changes using AdminManager, the username is root 
and the default password is the last six characters of the Ethernet (MAC) 
address (any alpha characters must be in upper case).
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USING TELNET

EXAMPLE TELNET CONFIGURATION

TELNET requires the print server to have a valid IP address configured. If the NIC already 
has an IP address configured, skip steps 1 to 3 below.

1. Use the PING command to confirm the connection with the network card.

Example

For IP address 172.168.20.127:

ping 172.168.20.127

If there is no reply, there is a problem with the configuration of the IP address (the 
IP address has been already set manually or by the DHCP/RARP server), or with the 
network. Reset the network interface card settings to the default and try to set a 
temporary IP address. If you still have the problem after resetting the network 
interface card, consult the network manager.

2. Login to the network card using TELNET.

Example

For IP address 172.168.20.127

telnet 172.168.20.127

You should see a sequence similar to the following example:

Trying 172.168.20.127
Connected to 172.168.20.127
Escape character is ‘^]’.
MC860 TELNET Server (Ver 01.05).
login: root
‘root’ user needs password to login.
password:
User ‘root’ logged in.
No. MENU (level.1)
------------------------------------
 1:Status / Information
 2:Device Config
 3:Network Config
 4:Security Config
 5:Maintenance
99:Exit setup
Please select (1-99)?

3. Enter the number of the item to be changed.

The details window for that item displays.

CAUTION!

Please ensure a valid IP address for your network environment is 
used. Use of an incorrect IP address can cause serious problems on 
your network.

NOTE
The method of configuring commands may differ between workstations. Refer 
to the workstation’s manual.
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4. When the configuration is complete, select Exit Setup to save your change. To exit 
without saving your modification, select Quit.

5. Turn the machine off and on again. 

NOTE
The network card continues to use pre-transmission settings until the machine 
is turned off and back on again.
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USING SNMP

The machine and network card can be managed via a standard SNMP management station. 
The network card supports SNMPv1, MIB-II, Oki Data Private MIB and SNMP v3. In order 
for the machine to be managed correctly from an SNMP management station, the Oki Data 
Private MIB needs to be added to that management station. Please refer to the SNMP 
manager documentation for information on how to do this.

The printer’s trap address can be set in five places using TCP/IP and in one place with IPX.

Printer trap settings can be made with TELNET and a Web browser.

MANAGEMENT UTILITY — PRINTSUPERVISION

PrintSuperVision is a web-based application for managing printing devices connected to a 
network. It consists of two parts:

> A web application based on Microsoft web server (Internet Information Server, IIS 
or Personal WEB Server, PWS), that provides the user interface.

> A monitoring program (PrintSuperVisor) that runs all the time, collecting data and 
saving it in a database for statistical reports and sending E-Mail alerts based on the 
saved configuration.

PrintSuperVision requires the .NET environment to be installed on the PC on which it runs. 
The supplied installer will install this if necessary.

PrintSuperVision’s main functions are:

> Maintaining the list of printing devices and organising them in logical groups.

> Initially discovering and configuring printers connected to the network.

> Locating printers visually on maps.

> Monitoring devices over time and saving data for statistical reports.

> Sending email alerts when events occur that affects the functionality of printers.

> Statistical reports about usage of printers.

> Tracking maintenance data related to printers.

> Identifying part numbers of consumable items for use with your printer.

> Integrating with Oki Data’s on-line web support (for US and Canada).

> PrintSuperVision can even manage printers on another network provided a copy of 
PrintSuperVision is also running on that network.

NOTE
Not all utilities, features or protocols are supported by every product. Please 
check with your User’s Guide and support website for latest information.

NOTE
The Oki Data Private MIB file can be found in the MIB folder on the CD-ROM 
or support website. Please refer to the readme file for further information.

NOTE
Not all utilities, features or protocols are supported by every product. Please 
check with your User’s Guide and support website for latest information.
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SYSTEM REQUIREMENT

The main PrintSuperVision application can be installed in any of the following Windows 
systems.

Supported Browsers

The PrintSuperVision application can be accessed from most Windows, Macintosh, Unix, 
and Linux desktops.

PrintSuperVision works best when used with Internet Explorer. When using the Netscape 
browser, do not select the option Images off as the hyperlinks may not work properly. 
Some versions of Netscape browser do not display the frames properly, and the Back 
button may not work correctly.

OPERATING SYSTEM SERVICE 
PACK

IISA

a. An Embedded Web Server option is provided which does not require IIS.

MDAC AND .NET 
FRAMEWORK

Windows Vista

1. Ultimate Edition

2. Home Premium Edition

3. Business Edition

IIS 7.0 included in 
the OS. 

PSV uses PkgMgr to 
install the IIS 7.0 if 
selected.

PSV installs IIS 6.0 
Manager.

.Net Framework 2.0 
installed as part of 
the OS.  .Net 
Framework Version 
1.1 included as part 
of PSV install.

Windows 2003 Server 

1. Web Edition

2. Standard Edition

3. Enterprise Edition

4. Datacenter Edition

R2 IIS 6.0 included in 
the OS.

1. IIS 6.0 installed 
by default.

2, 3, 4. IIS 6.0 
optionally installed 
(on the CD).

.Net Framework 1.1 
installed as part of 
the OS.

Windows XP Professional SP2 IIS installed as an 
option. Available in 
the Windows XP CD.

Install IIS before 
installing .Net 
framework.

MDAC and .Net 
Framework are 
available for 
download from 
Microsoft.

MDAC 2.8 and .Net 
Framework Version 
1.1 are included as 
part of PSV install.

Windows XP Home SP2 Works only with PSV 
Embedded Web 
Server, available in 
the PSV Install 
Package.

Windows 2000 
Professional

SP4 Internet Service 
Manager included in 
the OS. Available in 
the Windows 2000 
CD.

Install IIS before 
installing .Net 
framework.

Windows 2000 Server / 
Advanced Server / 
Datacenter Server

SP4
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Supported Printers

PrintSuperVision provides general management information for printers connected to the 
network. For Oki printers, additional details, reports and added features are available.

While the printer properties are displayed in PrintSuperVision, only a few of the printer 
settings can be set. For setting any other printer settings, a hyperlink to the printer’s web 
page is provided in PrintSuperVision.

INSTALLING PRINT SUPERVISION

This section describes installing Print SuperVision from the supplied CD-ROM.

1. Insert the CD-ROM into the CD-ROM drive. The Setup Utility starts automatically. 
If it does not start, double-click \setup.exe on the CD-ROM.

2. Select Software Utilities.

3. Select Install PrintSuperVision.

4. When installation ends, the Setup complete screen is displayed. Click Finish. 

5. Now you should select: Start > Programs > PrintSuperVision> 
PrintSuperVision or double-click the PrintSuperVision icon on the desktop for 
the PrintSuperVision server. 

6. For PrintSuperVision client, access http://server IP address or host name/
PrintSuperVision from the Web browser. If you change the port number you should 
add port number. Example: http://192.168.20.127/PrintSuperVision:81.

7. PrintSuperVision has an on-line help facility.

UNINSTALLATION

To uninstall PrintSuperVision, either select: Start > Programs > PrintSuperVision > 
Uninstall PrintSuperVision, or from Control Panel, select Add/Remove Programs, 
select PrintSuperVision from the index window and click Add/Remove. When the 
uninstallation is completed, close Add/Remove Programs.

In some cases, an empty PrintSuperVision/ directory may be left behind. Delete the 
directory manually.

PRINTING UTILITY — OKI LPR

The Oki LPR Utility is a utility that allows printing data to printers connected to the network 
via TCP/IP. 

The utility is for those Oki printers which support TCP/IP and redirects printing data to the 
lpr port of the specified IP address.

It is an alternative method of connecting printers instead of using the Microsoft TCP/IP port.

SYSTEM REQUIREMENT

Operating Systems with TCP/IP support and Oki printers that support TCP/IP.

NOTE
Some Operating Systems require administrator privileges in order to make 
changes.

NOTE
Not all utilities, features or protocols are supported by every product. Please 
check with your User’s Guide and support website for latest information.
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TO INSTALL THE OKI LPR UTILITY

1. Set up the printer driver by designating the output destination to Local Printer 
(LPT1:). For information on setting up your printer driver, see the printer user guide.

2. Insert the CD-ROM into the CD-ROM drive. The Setup Utility starts automatically. 
If it does not start, double-click setup.exe on the CD-ROM.

3. Select Software Utilities.

4. Select Install OkiLPR.

5. Follow the on-screen instructions.

6. Click Next when the Welcome screen is displayed.

7. Verify Destination Folder and Spool Folder and click Next.

8. Check Register in Startup if you want automatic startup as Windows boots up. 
Check Launch as minimized if you want to startup in the Icon state and click 
Next.

9. Verify the program folder name and click Next. The installation starts.

10. When the installation ends, the Setup complete screen is displayed. Check Yes, I 
want to launch Oki LPR Utility now and click Finish. Check Yes, I want to view 
the ReadMe File if you want to read Readme. The OkiLPR utility will start.

11. You may be asked whether it is OK to change write permissions for the spool 
directory. Click Yes to allow the utility to be correctly installed.

12. Select Add Printer on the Remote Print menu.

13. Click Discover… to search for the IP address of a suitable printer on your network.

14. Highlight the printer you will use and click OK.

15. If your printer is not discovered, click Cancel and you can type the IP address 
directly at IP Address:.

16. Enter an IP address at IP Address and click OK. A printer is added to the main 
window.

Refer to the On-line Help for information on how to use the utility.

UNINSTALLATION

1. Stop the OkiLPR Utility.

2. Select Start > Programs>Okidata>OkiLPR Utility > Uninstall OkiLPR Utility.

You may find this under Start > All Programs in Windows XP.

3. Click Yes when the Confirm File Deletion dialogue is displayed. Deletion of the 
OkiLPR utility starts.

4. When the deletion has finished, the Uninstall Complete screen is displayed. Click OK.

If a file that has been added after installation exists in the folder to install the OkiLPR utility 
or the folder to spool, you cannot delete the folder. Delete any unwanted files before 
running Uninstall OkiLPR Utility.

NOTE
Some Operating Systems require administrator privileges in order to make 
changes.
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MICROSOFT WINDOWS

OVERVIEW

This chapter provides guidelines on how to print over the network from various Microsoft 
Windows platforms. There are numerous ways of printing from Windows and the exact set-
up will vary depending upon your environment. There are also numerous versions of 
Windows, which can be configured as either a client, server or both.

Although there are many variants of Windows, the principles of network printing are the 
same. Microsoft provides on-line help with all of their operating systems and this is a good 
reference point for the exact details of each configuration option within Windows.

INSTALLING A NETWORK PRINTER

There are two ways to set up a Network Printer:

> Install automatically, using the Oki Driver Installer

> Install it yourself using the Add Printer Wizard

USING THE OKI DRIVER INSTALLER

The Oki Driver Installer program searches for compatible printers on the Network, then 
installs and configures the printer drivers with the correct port settings automatically.

Using the Oki Driver Installer program, you can install to the following connected printer 
types:

1. Locally connected printers

> USB port

> Parallel port

2. Networked printers

> Directly connected (peer-to-peer) printers via TCP/IP 

The Microsoft standard TCP/IP is installed and configured to use Port 9100 with the 
printer’s IP address.

> Printers not directly connected, but shared via a PC (Client Server)

Why use the Oki Driver Installer?

> Automatically discovers printers on the Network (TCP/IP)

> Installs driver and correctly assigns the appropriate port and IP address

> Allows easy configuration and sharing of the printer with other Network users

> Automatically configures the printer driver with the appropriate hardware device 
options such as hard disc drive, duplex unit, etc. (via the Oki Network Extension 
software)

NOTE
Not all utilities, features or protocols are supported by every operating 
system. Please check with your User’s Guide and support website for latest 
information.
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USING THE ADD PRINTER WIZARD

Method summary:

The following table shows the different ways to connect to the printer (port types).

About the different methods

Windows Rally

Windows Rally is an automated “Plug-n-Play” type utility that allows users to discover and 
configure network devices effortlessly.

Windows standard TCP/IP port

The standard TCP/IP port simplifies connecting to remote printers using the TCP/IP 
protocol. A computer that acts as a print server must run the TCP/IP protocol in order to 
print.

Can be configured to use either LPR or RAW (e.g. Port9100).

OkiLPR

Used to connect your printer over TCP/IP using an LPR port.

OkiLPR also includes useful tools enabling you to download PS and PRN files directly to your 
printer and automatically redirect jobs to other printers on the network.

IPP

The IPP (Internet Printing Protocol) defines a standard protocol for printing as well as 
managing print jobs, media, resolution, etc.

NetBEUI

NetBEUI (NetBios Extended User Interface) is a protocol that was designed for use in small 
workgroups or LANs. Within Windows NetBEUI is used for file and printer sharing between 
computers. It provides a simple method of printing, but it does have limitations, and is not 
as robust as TCP/IP or IPX. Typically it is employed in small business or home networks.

WINDOWS 
2000

WINDOWS 
XP

WINDOWS 
VISTA

Windows Rally NO NO YES

Windows 
standard TCP/IP

YES YES YES

Oki LPR YES YES NO

IPP YES YES YES

NetBEUI YES YES NO
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NETWORK PRINTER IP ADDRESS CONFIGURATION

Use the Standard Set-up Utility to configure the IP Address, Subnet Mask and Gateway.

1. Connect the machine to the network and turn on. 

2. Insert the CD-ROM into the CD-ROM drive. The Setup Utility starts automatically. 
If it does not start, double-click \setup.exe (in the root directory) on the CD-
ROM.

3. If you agree to the User Licence Agreement, click Next.

4. Select the appropriate language.

5. Select Software Utilities 2.

6. Select the Network Setup Card Install link.

7. Select your language.

8. Select Oki Device Quick Setup and follow the on-screen instructions.

9. Select the appropriate network card, using the Ethernet address to identify it, and 
click Next. 

The Ethernet address of the printer can be found on the self-diagnostic printout, 
which can be printed by pressing the push-button on the network card panel for more 
than three seconds and then releasing it.

NOTE
It will not be necessary for printers connected to a network using DCHP to use 
this setup method.

Some steps may not display depending on the network protocols installed.

5
6
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Using TCP/IP protocol

When using lpr in UNIX and other TCP/IP environments, please select Yes. To use in 
a TCP/IP environment, an IP address should be assigned to the Ethernet card. 

If Yes has been selected and TCP/IP is the only working protocol and the IP address 
has not already been assigned, you can either obtain an IP address automatically or 
assign an IP address.

When Obtain an IP address automatically is selected, the device IP address will 
be automatically assigned by the DHCP server. In an environment without a DHCP 
server, please assign the IP address manually. 

If you are manually assigning an IP address, you need to enter:

> An IP address

> Subnet mask

> Gateway address. 

10. Click Next.

Using Bonjour protocol

Bonjour is the preferred protocol for printing data from the Macintosh environment.

Using NetBEUI protocol

Using NetBEUI makes it easy to manage your Oki product and print within the 
network environment of Windows.

11. When the settings are correct, click Execute. The new settings are transmitted to 
the network card but it still operates with pre-transmission settings.

12. Click Finish to validate the new settings. 

13. Switch the printer off for 15 seconds and on again.

Now that both Windows and the printer have been configured to use TCP/IP, the next step 
is to configure Windows to print to the network printer.

NETBEUI PROTOCOL

NETWORK PRINTER SETTINGS

There are two configurable items under NetBEUI within the printer. These can be 
configured using the standard set-up utility described in “Device setup” on page 12.

Although there are some differences in configuration options between the various Windows 
platforms, the procedure for printing using NetBEUI is the same.

Please ensure the NetBEUI protocol has been installed in Windows. This can be confirmed 
by checking the network settings. If NetBEUI has not been installed please refer to the 
section below.

The relevant Windows installation CD-ROM may be required and you should follow the on-
screen dialogue box prompts.

COMPUTER NAME NAME ASSIGNED TO THE PRINTER

Workgroup PrintServera

a. Although the workgroup name can be changed, it is recommended 
that it remains as PrintServer.

Comment User definable description
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WINDOWS XP

Although you can install the NetBEUI protocol into Windows XP, it may not be supported. 
You should be able to use NetBEUI on LAN connections although you will not be able to use 
this on a Remote Access Service Connections.

1. In the Start menu, select Settings > Control Panel.

2. Double-click on Network Connections.

3. Right-click the adapter you wish to add NetBEUI to and then click Properties.

4. On the General tab, select Install.

5. Select Protocol and then Add.

6. Select Have Disk and insert your Windows XP CD-ROM, open the 
Valueadd\msft\net\netbeui folder, select the Netnbf.inf file and then click Open.

Now the printer has been configured and NetBEUI has been installed, you can configure 
Windows to print over the network.

WINDOWS VISTA

NetBEUI is not supported by Windows Vista.

PRINTER DRIVER CONFIGURATION

In the following example, the printer has been configured as follows:

1. Set up the printer driver as the default local printer.

2. In the Start menu, select Settings > Printers.

3. Select the relevant printer driver, then Properties.

4. Click on the Details tab in the printer driver.

5. Select Add Port.

6. Select Network and click Browse.

7. Double-click Entire Network, PrintServer and OL07DB85. 

8. Select Prn1 and click OK.

9. Check that Network is selected and click OK. 

10. Select Apply and OK to close Properties.

Printing can be carried out using your application software.

> The Master Browser function manages machine information from the same 
Workgroup, and replies to summary requests from other workgroups.

> The Master Browser function operates only if the Workgroup name is PrintServer.

> The Master Browser function can only manage this network card. If the PrintServer 
name is put into another Workgroup, the network card will not be able to find it on 
the network.

> A maximum of eight Networks can be managed by the Master Browser function.

> Printing cannot be carried out and an error message appears when jobs from other 
users (including other protocols) are being printed.

Computer Name: OL07DB85

Workgroup: PrintServer

Comment: Ethernet Board 8100e
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APPLE MACINTOSH

OVERVIEW

This section of the guide is for administrators and it should be read in conjunction with the 
relevant MacOS manual. 

To get the best results from your printer, install the Postscript Printer Description (PPD) file 
supplied with your printer and use this to customise the Apple PostScript driver that is built-
in to the OS X. Features provided by the PPD file include:

> Supported paper types

> Paper trays

> Printer resolution

> Printer colour matching

SETTING UP A NETWORK PRINTER

1. If the printer does not already have an IP address, use the Printer Setup Utility to 
assign an IP address. See “The printer setup utility interface” on page 42.

To do this, you will need to know the printer's MAC address. This can be found on the 
print server's network summary printout. See “Self-diagnostic test” on page 7.

2. Install the printer driver software. This copies the printer driver files to the correct 
location on your Mac OS X system.

3. Make a connection to the printer by USB, TCP/IP, Bonjour or AppleTalk. See 
“Connecting to your printer” on page 48.

4. If required, enable hardware device options such as additional paper trays or printer 
hard disk. See “Configuring printer hardware options” on page 51.

MACOS PRINTER SETUP UTILITY

The Printer Setup Utility is a powerful MacOS-based utility for configuring all print server 
functions using a graphical user interface. 

INSTALLING THE PRINTER SETUP UTILITY

1. Insert the CD into the CD-ROM drive.

2. Open the Printer Setup Utility folder and double-click Installer.

NOTE
The PPD file must be installed using the Oki Driver Installer to ensure that all 
essential files are copied.
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3. Select the destination directory, then click Next.

4. Ensure the Yes option is selected to activate the utility, then click Finish.

THE PRINTER SETUP UTILITY INTERFACE

The Printer Setup Utility auto-discovers Oki compatible network cards.

1. Select the correct printer NIC to configure and choose Setup menu > Oki Device 
Setup. 
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2. At the prompt, enter the Admin password.

3. Select the TCP/IP tab and assign your machine’s IP address.

4. Click Apply.

MENU OPTIONS

Network Device Search

Locates and lists all printers in your network which have an Oki compatible network 
card installed.

System status

Displays the network card summary details.

Oki device seup

Use this to configure the network card settings (requires Admin password).

NOTE
The default admin password is the last six digits of the MAC Address, minus 
any punctuation marks. e.g., for a MAC (Ethernet) Address of 
00:80:87:A4:55:79, the password would be A45579.
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General Tab 

The General tab allows you to change the admin password.

1. Click Change.

2. Enter the current value, then enter the new value and re-enter it under Confirm ….

3. Click OK.

4. Click Apply.

TCP/IP Tab 

NOTE
The default admin password is the last six digits of the MAC Address, minus 
any punctuation marks. e.g., for a MAC (Ethernet) Address of 
00:80:87:A4:55:79, the password would be A45579.

ITEM COMMENTS 

Use TCP/IP Protocol Enable/disable TCP/IP protocol. 

Use DHCP/BOOTP Click to select this item if the IP address, subnet 
mask, default gateway and IP addresses for DNS 
primary server and secondary servers are retrieved 
from the DHCP or BOOTP server. 

IP Address Set the IP address of the selected network interface 
card.

Subnet Mask Set the subnet mask of the selected network 
interface card. 

Default Gateway Set the default gateway of the selected network 
interface card. 

Use IPv6 Function Use to enable/disable IPv6.
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Netware Tab

EtherTalk Tab

ITEM COMMENTS

Use NetWare Protocol Enable/disable NetWare protocol.

Print Server Name Set a Print Server name. 

Frame Type Set the primary NetWare frame type. 

Operation Mode Select the NetWare mode:

PSERVER Mode (the default)

RPRINTER Mode

Bindery Setup Configure Bindery mode items, including:

File Server to be 
connected.

Specify up to 8 file 
servers to connect. 

Password. Set a password for the 
Print Server.

Job Polling Time Set the print job 
polling interval in 
seconds.

NDS Setup Set the NDS Tree and Context where the Print 
Server was created.

Printer Name Set the NetWare printer object name.

ITEM COMMENTS

Use EtherTalk 
Protocol

Enable/disable EtherTalk protocol.

Printer Name Set the EtherTalk Printer object name.

Zone Name Set the name of the zone to which the print server 
belongs. 
Apple Macintosh > 45



NetBEUI Tab

SNMP Tab

Configuration via HTTP

Displays the printer web page.

Environment setup

Use this to configure the utility preferences for broadcast addresses for TCP/IP 
protocol and Time Out.

ITEM COMMENTS

Use NetBEUI 
Protocol

Enable/disable NetBEUI protocol.

Short Printer Name Set a name for the print server. 

Workgroup Set a name for the work group to which the print server  
belongs.

Comment Set the comments for the print server.

ITEM COMMENTS

SysContact Set the printer manager name.

SysName Set the printer model name. 

SysLocation Set the location where the printer is installed.
Apple Macintosh > 46



TCP/IP Tab

Timeout Tab

ITEM COMMENTS

Set Broadcast 
Address

Set broadcast addresses that are used to search Oki 
network interface cards using the TCP/IP protocol.

Add Click Add to add the address to the list in the box.

Delete Select an address in the box, then click Delete to 
remove it.

ITEM COMMENTS

Set Timeout: 
Printer Search

Search Every (20-180sec)
Set the response waiting time from the 
network card in seconds. Default is 30 
seconds.

Set Timeout:
Data Send/
Receive

Time Outs (1-60sec)
Set time out between AdminManager and the 
network interface card in seconds. Default is 5 
seconds.

Retry (1-5)
Sets how many times AdminManager will retry 
to transmit/receive data to/from the network 
interface card. Default is 3 retries.
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CONNECTING TO YOUR PRINTER

TIGER (10.4)

Bonjour, AppleTalk or USB

1. Launch Printer Setup Utility

This is located in the Applications > Utilities folder.

2. Click Add….

3. Select your printer model from the Default Browser.

4. Click Add.

Depending on the connection type, you may be prompted to configure any additional 
printer hardware options. If your printer has options such as a hard disk or second 
tray, switch on the relevant options.

5. Quit Printer Setup Utility.

TCP/IP Connection

1. Launch Printer Setup Utility

This is located in the Applications > Utilities folder.

2. Click Add….

3. Click the IP Printer button.

4. From the Protocol menu, choose Line Printer Daemon – LPD.

5. Enter the printer’s IP address in Address.
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6. Check the correct PPD file for your printer is selected in the Print Using menu.

7. Click Add....

You will be prompted to configure any additional printer hardware options. If your 
printer has options such as a hard disk or second tray, switch on the relevant options.

8. Click Continue.

9. Quit Printer Setup Utility.

PANTHER (10.3) AND JAGUAR (10.2)

Boujour/Rendezvous

If you have not already done so, run the Oki software installer before following the steps 
below. 

1. Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

2. Click Add....

3. From the pop-up menu, choose Rendezvous(for OSX 10.2).

4. Select the printer you wish to connect to.

5. Click Add.

6. Click the Printer Setup Utility menu, and choose Quit Printer Setup Utility.

After adding the printer, you should configure printer hardware options. Refer to 
“Configuring printer hardware options” on page 51.

IP CONNECTION

If you have not already done so, run the Oki software installer before following the steps 
below.

1. Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

2. Click Add....

3. Click the pop-up menu and choose IP Printing.

4. Click the Printer Type menu and choose LPD/LPR.

NOTE
> This utility is called Print Center on Mac OS X 10.2.x.

> If your printer is already listed, your Mac may already have discovered the 
printer before you installed the Oki software. In this case, the printer may 
be using the incorrect PPD file or may not have the correct hardware 
options configured. You should delete the printer, quit Printer Setup 
Utility, and re-launch the utility before continuing.

NOTE
> This utility is called Print Center on Mac OS X 10.2.x.

> If your printer is already listed, your Mac may already have discovered the 
printer before you installed the Oki software. In this case, the printer may 
be using the incorrect PPD file or may not have the correct hardware 
options configured. You should delete the printer, quit Printer Setup 
Utility, and re-launch the utility before continuing.
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5. Enter the printer's IP address.

To find the printer’s IP address, you can print a configuration page from the printer’s 
operator panel. Refer to the User’s Guide for details.

The Configuration pages are printed. The printer’s IP address is shown under the 
Network section on the first sheet.

6. Enter the queue name. If you do not know the queue name, leave it as Use Default 
Queue on Server.

7. Click the pop-up menu and choose your printer model.

8. Click Add.

9. Click the Printer Setup Utility menu, and choose Quit Printer Setup Utility.

After adding the printer, you should configure printer hardware options. Refer to 
“Configuring printer hardware options” on page 51.

AppleTalk connection

If you have not already done so, run the Oki software installer before following the steps 
below.

1. Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

2. Click Add....

3. From the pop-up menu, choose AppleTalk.

4. Select the printer you wish to connect to.

5. Click Add.

6. Click the Printer Setup Utility menu, and choose Quit Printer Setup Utility.

USB connection

If you have not already done so, run the Oki software installer before following the steps 
below.

1. Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

2. Click Add Printer....

3. From the pop-up menu, choose USB.

4. Choose a printer to connect to.

5. Click Add.

6. Click the Printer Setup Utility menu, and choose Quit Printer Setup Utility.

NOTE
This utility is called Print Center on Mac OS X 10.2.x.

NOTE
> This utility is called Print Center on Mac OS X 10.2.x.

> If your printer is already listed, your Mac may already have discovered the 
printer before you installed the Oki software. In this case, the printer may 
be using the incorrect PPD file or may not have the correct hardware 
options configured. You should delete the printer, quit Printer Setup 
Utility, and re-launch the utility before continuing.
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CONFIGURING PRINTER HARDWARE OPTIONS

If you have added additional hardware, for example additional paper trays, to your printer 
these must be enabled in the printer driver.

1. Start the Printer Setup Utility.

This is located in the Applications > Utilities folder.

2. Ensure that your printer model is selected.

3. Click the Printers menu, and choose Show Info.

4. From the popup menu, select Installable Options.

5. Select any options appropriate to your hardware, and click Apply Changes.

PRINTING THE CONFIGURATION PAGE

The printer’s configuration page reports information that is required for Macintosh 
configuration. To print a configuration page, while the printer is switched on, depress the 
NIC’s push-button for more than three seconds and then release.

The first six characters of the Ethernet address are the same for all network cards. The last 
six characters of the Ethernet address are unique to each card.

NOTE
Applies to IP and Rendezvous network connections only.

NOTE
This utility is called Print Center on Mac OS X 10.2.x.

NOTE
Not all utilities are supported by every operating system. Please check with 
your User’s Guide and your support website for latest information.
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UNIX

OVERVIEW

The printer supports many protocols such as LPD, FTP, TELNET, SNMP and IPP, and works 
within the UNIX environment.

To use the network card within the UNIX environment, the following steps are required:

CONFIGURATION

NETWORK INTERFACE CARD SETTING

The first step in installing the network card under UNIX is to set up the IP address, Subnet 
Mask and Gateway. This section explains one way to set them up from a UNIX workstation.

> The network addresses used in this manual are shown as examples only. Network 
addresses used in your installation must be generated for your own network.

> Log in as root to change the configuration of the printer.

> If an incorrect IP address, Subnet Mask or Gateway is entered, the network may go 
down or other damage may occur. Check the address with your network manager.

The following explanation uses Sun Solaris 2.8 (Solaris 8) as an example. The actual 
commands may differ between versions of UNIX, so refer to the workstation manuals for 
more information.

1. Log in as root to the workstation.

2. If the printer does not have an IP address already assigned, use the arp command to 
set a temporary IP address.

Example: for IP address 192.68.20.127 and network card address 
00:80:87:01:00:D2

# arp –s 192.168.20.127 00:80:87:01:00:D2

3. Use the ping command to confirm the connection with the network interface card.

Example: for IP address 192.168.20.127

# ping 192.168.20.127

If there is no reply, there is a problem with the configuration of the IP address (the 
IP address has already been set manually or dynamically), or with the network. Reset 
the network interface card settings to default and try to set a temporary IP address.

If you still have the problem after resetting the network interface card, consult the 
network manager.

NOTE
Not all utilities are supported by every operating system. Please check with 
your User’s Guide and your support website for latest information.

NOTE
If you do not have superuser rights, the network manager should conduct the 
configuration.
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4. Login to the network interface card using TELNET.

Example: Logging in to IP address 192.168.20.127

#telnet 192.168.20.127
Trying 192.168.20.127
Connected to 192.168.20.127
Escape character is ‘^’.
MC860 TELNET server (Ver 01.01).
login: root
‘root’ user needs password to login.
password: 
User ‘root’ logged in.
No. MENU (level.1)
1 : Status / Information
2 : Device Config
3 : Network Config
4 : Security Config
5 : Maintenance
99 : Exit setup
Please select (1- 99)?

5. Type 1 and press the Enter key. Perform the following settings:

Please select (1- 99)? 1
No. MENU (level.2)
1 : Device
2 : Network
3 : Version
99 : Back to prior menu
Please select (1- 99)?

6. Logout from the network interface card. Turn the printer off for about 15 seconds 
and on again to validate the settings.

LPD Printing

Line Printer Daemon (LPD) is the most common protocol for printing with TCP/IP to 
a network printer. Refer to the workstation’s manual for details of lpr and lp 
commands. The following explanation in this section uses the printing of print file 
test.prn with printer name myprn_lp as an example.
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Logical printers

The printer’s network interface includes three logical printers.

> lp must be used for printing a file created using the printer driver.

> sjis must be used for printing a text file of Shift JIS Kanji code.

> euc must be used for the printing a text file of the EUC Kanji code.

> sjis and euc function only as PostScript printers.

BSD-based UNIX

Print using the lpr command.

# lpr -P myprn_lp test.prn

If the lprm command is used, the print job is cancelled.

Example: To delete a print job (Job ID 123) on the myprn_lp 

# lprmp -P myprn_lp 123

Verify the printer status using the lpq command.

> The result of lpq may not be displayed correctly depending on UNIX operating 
system specification.

# lpq -P myprn_lp

System V-based UNIX

Print using the lp command.

# lp –d myprn_lp test.prn

Delete a print job using cancel command.

Example: To delete a print job (Job ID 456) in the myprn_lp

# cancel myprn_lp  -456

Verify the printer status using the lpstat command.

# lpstat -p mypm_1p

The result of lpstat may not be displayed correctly depending on UNIX operating 
system specification (e.g. Solaris 2.x).

FTP printing

FTP (File Transfer Protocol) is used for transferring a file with TCP/IP. If the print data 
is sent to a logical printer via FTP, it is printed.

Refer to the workstation’s manual for details of the ftp command. The following 
explanation uses print file test.prn with printer name myprn_lp as an example.

LOGICAL PRINTER PRINTER FUNCTION

lp For direct output

sjis For Shift JIS Kanji converted output

euc For EUC Kanji converted output
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LOGICAL DIRECTORIES

The printer’s network interface includes three logical directories.

> lp must be used for printing a file created using the printer driver.

> sjis must be used for printing a text file of Shift JIS Kanji code.

> euc must be used for the printing a text file of the EUC Kanji code

> jis and euc function only as PostScript printers.

> You can not send data to the root directory.

1. Log in to the network interface card.

When printing with ftp, use any values for name and password. However, if the user 
name is root, the password set under TELNET or the utility is required. See the 
appropriate section for details.

Example: Logging in with host name myprn (or IP address 192.168.20.127).

# ftp myprn (or ftp 192.168.20.127)
Connected to myprn
220 EthernetBoard 8100e Ver 01.50 FTP Server
Name (myprn:<none>) : root
331 Password required.
Password:<CR>
230 User Logged in
ftp>

The network card logical directory structure is hierarchical. Move to the logical 
directory; it is not possible to output print data to the root directory.

2. Move to the preferable logical directory using the cd command.

Example: moving to the lp directory and confirming the current directory.

ftp> cd /lp
250 Command OK.
ftp> pwd
257 ”/lp” is current directory
ftp>

3. Configure the transfer mode.

There are two types of transfer mode: BINARY mode, in which the file content is 
output as it is and ASCII mode, which converts the LF code to the CR+LF code. If a 
binary file converted by the printer driver is transferred, the transfer mode has to be 
BINARY mode.

Example: Changing transfer mode to binary mode and verifying the current mode:

ftp> type binary
200 Type set to I.
ftp> type
Using binary mode to transfer files.
ftp>

LOGICAL DIRECTORY PRINTER FUNCTION

lp For direct output

sjis For Shift JIS Kanji converted output

euc For EUC Kanji converted output
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4. Transfer the print data to the network card using the put command. Two methods of 
file transfer using the put command are available.

Example: Transferring print data test.prn

ftp> put test.prn

Example: Transferring print data specified by absolute path/users/test/test.prn

ftp> put /users/test/test.prn

5. Logout from the network card using the quit command.

ftp> quit

Three states can be verified using the quote command stat: the IP address, login user 
name and transfer mode. In addition, printer status can be verified by specifying the 
directory after the stat (lp, sjis, euc).

Example: Displaying network card status

ftp> quote stat
211-FTP server status:
Connected to: 192.168.20.10.000.00
User logged in: root
Transfer type: BINARY
Data connection: Closed.
211 End of status.
ftp>

Example: Displaying the network card status (directory name: lp)

ftp> quote stat /lp
211-FTP directory status:
Ready
211 End of status
ftp>
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TROUBLESHOOTING
The network addresses used in this manual are shown for example only. Network addresses 
used in your installation must be generated from your own network.

TCP/IP

COMPUTER CANNOT FIND THE NETWORK INTERFACE CARD

Turn the printer off for 15 seconds and then on again.

Confirm the network interface is enabled on the printer.

Check there is a response to the PING command.

Check that the network cable is correctly connected and that the green LED close to the 
printer’s network interface is lit. If not, change the cable and try again.

Run the Self-diagnostic test.

Check the IP Address, Subnet Mask and Gateway are correct.

Check that the TCP/IP protocol is set to Enable.

Reset the network interface card to factory default settings.

If DHCP, BOOTP and RARP are not used, ensure they have been set to Disable.

CANNOT PRINT WITH LPR AND FTP

Turn the printer off for 15 seconds and then on again.

Check there is a response to the ping command.

Check the network cable is correctly connected.

Change the cable and try again.

Check the host name and IP address are configured in the workstation.

Check the printer port name is configured in the workstation.

There are three port names: lp, euc and sjis. Use lp by default as euc and sjis are specific 
to PostScript printers.
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NETBEUI

THE NETWORK INTERFACE CARD IS NOT IDENTIFIED.

Turn the printer off for 15 seconds and then on again.

Check the network cable is correctly connected. 

Change the cable and try again.

Check Microsoft Network Client and NetBEUI have been added to the network section of 
the Windows Control Panel.

Check the NetBEUI protocol is set to Enable.

Check the factory setting of the workgroup name is PrintServer and the computer name 
is ML+ the last six characters of the MAC address.

Check the computer name of the NIC is different from the computer name on the network.

ERROR WRITING TO PRN1

Check the printer is online.

If there is an error message indicating the paper has run out, add more paper and cancel 
the error.

Check whether another user is printing. Print after the other user has finished.

MAC

BLANK PAGES OR GARBLED TEXT PRINTED

Symptoms:

When printing via a USB or TCP/IP connection, you receive blank pages or pages printed 
with a line of garbled text.

Cause:

This issue is normally caused by the data being sent to the printer in binary format. The 
printer may not be able to understand data in this format, and therefore may print blank 
pages or garbled text.

Solution:

In your applications print options, there may be an option to send data as ASCII. Choose 
this option, and print your document.

For example, in Adobe Photoshop 7 or Adobe Photoshop CS: 

1. Click the File menu and select Print with Preview. 

2. Click the box Show More Options.

3. From the pop-up menu, choose Output.

4. From the pop-up menu Encoding, choose ASCII.
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NO PRINTING OR PRINT QUEUE STOPPED

Symptoms:

Upon sending a job to the printer, the job disappears completely and is not printed, or the 
job remains stalled in Printer Setup Utility (Print Center).

Cause:

The Oki printer PostScript Printer Description (PPD) file has a dependency on a filter file. 
This filter file must be installed the following location:

/usr/libexec/cups/filter/OkfilterA

If this file is deleted, or is not present on your computer, jobs will not be sent to the printer 
at all. This can happen if you deleted this filter file, or if you copied a PPD file from another 
Mac and did not use the Oki Software installer.

Solution:

Run the Oki printer software installer contained on the CD-ROM supplied with your 
printer. This will install the CUPS filter file and allow normal printing.
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